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Introduction 
 

ACBLscore, a free download from www.ACBL.org, the American Contract Bridge Leagueôs 

website, is a great aid to the Duplicate Director, but it has some tricky aspects.  Covering some 

of these aspects of the Windows program may minimize the frustration from these quirks.  The 

opening screen of the Windows version is shown below. 

 

 
 

 

Club Mode 
 

On the opening screen below the ACBL symbol is a 2-line gray information bar.  The bottom left 

item of that bar should say Club Mode .  If it doesnôt, on the 1-line gray Menu bar near the top, 

click the Setup drop-down menu (4
th
 from the left), then the 4

th
 choice down Tournament/Club 

Mode.  From the list that pops up select Club Mode. 
 

Later in this paper thereôs a lengthy dissertation on Club Setup (under the Data Base menu).  By 

entering club information in the Club Setup window, you save yourself from having to enter the 

same information over and over each time you direct a game at that club. 

 

 

Other Setup Options 
 

The drop-down Setup menu contains a number of other useful selections, among them Set Path, 

Set Printer, and Game Options.  As with selecting the operating mode, a selection here stays in 

effect until you change it via the Setup menu. 
 

Set Path allows you to specify the computer path where your game files will be stored and 

retrieved and also the path where player information will be stored and retrieved.  The default 

values for both of these paths should generally serve you well.  Reasons for modifying these 

paths and how to do so are covered later in this paper in the section titled Set Path. 
 

Set Printer brings up a window with two choices.  Most likely the 2
nd

 choice, Windows printer 

Options, will be the one to select.  That, in turn, brings up a window allowing you to select your 

specific printer. 
 

Game Options brings up a window with 3 options that you may check or not.  At least two of 

them seem to be useful:  Allow Edit of Names in Game File and Allow Auto Stratification.  Both 

http://www.acbl.org/
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of these should normally be checked.  (Allow Remote score entry is most likely used in 

conjunction with the on-table, wireless electronic scoring devices.) 

 

 

Date Format 
 

Date entries in ACBLscore take the form of 2 digits for the Year, 2 digits for the Month, 2 digits 

for the Day, 6 digits total.  Pad the 3 individual entries with a leading zero (0) if needed.  

Symbolically, the date can be displayed as YYMMDD ïorï yymmdd.  This YYMMDD format 

is required by ACBLscore. 

 

 

The Game File 
 

When you click Game in the upper left of ACBLscoreôs opening screen, a window pops up with 

the Event file name given in YYMMDD format, highlighted in blue.  The specific numbers are 

based on the date on your computer.  Again, this YYMMDD format is required by ACBLscore, 

so if you need a different date, be sure to enter it in YYMMDD order. 
 

 
 

Below the Event file name you need to enter M, A, or E depending upon whether the game is 

Morning (before noon), Afternoon or Evening (after 6 P.M.).  There is a 4
th
 choiceðL for Late 

(after midnight)ðthat is not normally used at the club level. 
 

Once you OK setting up a new game, the game file (which has an ACx extensionðwhere x is M, 

A, E, or L) is automatically created and opened.  In the window show above, the file name would 

be ñ110322.ACM.ò 
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At the top of the new window (pictured below), youôll see an entirely different menu structure.  

This game file is saved periodically ñbehind the scenesò as you define / update the game 

parameters/results, so thereôs no ñsaveò button for you to press. 
 

 
 

 
 

 

Adding a Section 
 

The first step in defining your specific game file is adding a section.  Do this by pressing 

<Ctrl>A. 

 

 

Special Games 
 

Among the Special Games offered by ACBL is the ACBL-Wide International Fund Game.  

When selecting the game type, selection 3 Fund (Charity, International, Junior, etc) seems 

appropriate, but it turns out to be the wrong one.  Selection 8 ACBL/World/District Wide 

(Instant, Seniors, etc) is the correct choice. 

 

 

Setting up the Strats 
 

In the process of setting up the game parameters, youôll have the option of stratifying the event, 

or not.  For the Ventura Unit, Unit 547, you should stratify the game and should have 3 strata.  

When you select the number of strata, do not be misled by choice #2ð2 strata.  Itôs not saying, 

ñyes, stratify;ò itôs saying, ñI want exactly 2 strata.ò  You need to select the line below it that, in 

essence, says, ñI want exactly 3 strata.ò 
 

Note, until approximately summer of ô09 the stratum for a pair was always based on the 

Masterpoints of the higher ranked member of the pair.  At that time two new choices were added 

below the existing 3, allowing stratification based on the average masterpoint holding of the pair. 
 

As the Director, you have control over where to break the strata ð unlimited/1000/500  -or-  

unlimited/1000/300  -or- é. Typically, my personal choices are: 

 Strat A:  Open 

 Strat B:  Other Upper MP limit ð then enter 1000 

 Strat C:  Upper MP limit = 500 

For Strat C, other popular choices are: 

 Non Life Masters 

 Upper MP limit = 300 
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If you inadvertently select 2 strats (or 1), you can fix things later (but not too much later) by 

using the <F9> key (Set Configuration) and choosing selection 10, Set masterpoint rating.  

Youôll have to drill down a few levels to reach the entry for the number of strata.  Try to correct 

the number of strata before entering the player names so auto stratification (covered in the next 

section) will have the proper strata to work with. 

 

 

Auto Stratification 
 

If you do stratify one or more games, a useful option under the Main Menuôs Setup selection is 

Allow Auto Stratification, which is actually another level down under Game Options.  First select 

Setup, then Game Options, and finally ensure that Allow Auto Stratification is checked.  With 

Auto Stratification checked, after entering the 2
nd

 player of each pair, ACBLscore will 

automatically determine the proper strat for that pair. 

 

If you goofed when setting up the strata (in the game file), or you notice later that the 

breakpoints you selected put almost everyone in the same strat, you may change the number of 

strata and/or the breakpoints by using the <F9> key (Set Configuration) and choosing selection 

10, Set masterpoint rating.  Youôll have to drill down a few levels to reach the entry for the 

number of strata and strata breakpoints.  After youôve reset the strata, youôll want to select Edit, 

Strata (ST), <F3> to auto stratify with the new values. 

 

 

Entering Player Names 
 

When youôre ready to enter Player Names, you may click Edit (2
nd

 from the left) and then Names 

or just hit the <F3> function key. 

Respond ñYesò when asked about using the Data Base. 

ACBLscore pops up a table with columns for the N-S numbers and names, and columns for the 

E-W numbers and names.  (The columns with the pair numbers are filled in by ACBLscore.) 

Hit <Enter> to go to the Last Name of the 1
st
 Player of N-S pair 1. 

Type in the personôs last name and hit <Tab>  -or-  type in just the 1
st
 few letters and <Tab>. 

ACBLscore pops up a list of players with that last name  -or-  last names that start with those 1
st
 

few letters. 

If there are several choices, you may select the correct one by scrolling to it or by typing the 1
st
 

letter of the 1
st
 name.  With the correct name selected, click OK. 

(ACBLscore fills in the rest of the fields.) 

Type the last name of the 2
nd

 pair member and hit <Tab>  -or-  type in just the 1
st
 few letters and 

<Tab>. 

Again, ACBLscore pops up a list of players with that last name  -or-  last names that start with 

those 1
st
 few letters. 

Select the correct one as described above and click OK. 

(ACBLscore fills in the rest of the fields.) 

Click OK (or hit <F9>) when done with both names of a pair. 
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If , in the course of selecting names, you make a mistake, you may need to use the <F5> key 

repeatedly to erase the erroneous line entirely.  Sometimes you even have to erase both player 

entries and start that pair from scratch. 

If youôve set up more than 1 stratum and didnôt turn Auto Stratification on, ACBLscore will pop 

up a window, suggesting a Strat for this pair.  Based on your knowledge of the players and the 

masterpoints displayed by ACBLscore, ensure the proper strat is entered.  (Remember, the 

stratum may be based on the Masterpoints of the higher ranked member of the pair or on the 

average of the pair depending upon your earlier selection.)  If your entry is higher than needed 

based on the Data Base, ACBLscore will tell you that and allow you to correct your entry.  If no 

ACBL number is entered for a person, you are to assume that person is in Strat A, unless you 

know otherwise.  If Auto Stratification is on, ACBLscore automatically enters the strat. 

To move to E-W pair 1, you may use the right arrow key, hit <Tab>, or use the left arrow key.  It 

turns out that the left/right arrow keys and the <Tab> key are simply toggles that move from one 

side of the line to the other. 

To move down to the next pair on a given side, use the down arrow key. 

To move up (to correct an entry), use the up arrow key. 

The <Esc> key allows you to back out of an entry box without saving any new entries you made 

there. 

When a N-S or E-W pair is highlighted in the table, you may hit <Enter> to pop up the window 

for entering the names.  You may also click on the highlighted portion or hit most any other key. 

 

 

Correcting the Stratification Level of a Pair 
 

Should you realize after the fact that you have the wrong stratum for a pairðwhich, in theory, 

shouldnôt happen with Auto Stratification onðone technique to correct that error is to go back to 

the Names entry, reselect that pair, go to the 2
nd

 member of the pair, and hit the <F5> key to 

delete the 2
nd

 name.  Reenter that person and select the right stratum for the pair.  (If you have a 

non-ACBL member, ACBLscore assumes that person is in strat A, which will be unfair if you 

know the person is only moderately experienced at best.) 
 

If youôve mangled a number of strata entries, either individually or by proceeding with too few 

strata to start, youôre better off bringing up the ñStrata tableò and making your wholesale changes 

there.  Start by selecting the Edit pull-down menu (2
nd

 from the left) and then Strata (ST).  This 

selection brings up a table of N-S and E-W names accompanied by the currently selected strata 

and the Masterpoints of either the pair member with the most points or the average of the pair.  

You may either hit <F6> or use the arrow keys to enter the stratum (STR) column.  When 

finished with a pair, use the Up/Dn arrow keys to move within a column.  The <Tab> key 

toggles the cursor between N-S and E-W.  If you donôt need to override ACBLscoreôs automatic 

stratification, the simplest thing to do is use the <F3> key to stratify the entire table. 

 

 

Increasing the Number of Boards per Round and Resequencing Them 
 

As a director, you are aware that there are a number of possible situations that lead to having 

fewer tables in play than planned.  Sometimes this shortfall requires adding board(s) to the 



Preliminary  06/06/07 
  Updated:  03/23/11 

6 / 17 

number of boards per round.  If you catch this problem too late, you may have to add boards that 

are out of sequence.  If thatôs the case, then you need to edit the movement in ACBLscore.  The 

procedure is similar in the DOS and Windows versions. 

 

Letôs assume youôve entered the correct number of boards per round in ACBLscore.  If not, 

youôll need to go through the Set Configuration (SE) option, which is also reached by the <F9> 

key in the Windows version.  Start with selection #5, Change movement parameters.  Youôll 

have to wade through the menus until you get to the right one and correct the number of boards 

in play.  (And whatever else might need correcting.) 
 

With the correct number of boards per round established, hereôs the Windows procedure to 

change the board sequencing. 
 

Resequencing the Board #s in Windows 

 

When in the Game option/mode, select Edit (2
nd

 from left). 

Select Edit Movement (EDM) (last selection) 

Select option 1:  Display or reassign board sequencing and click OK. 

A matrix for Board Setup for round one will pop up. 

Go through the matrix substituting the actual last board of the round for the 

normal board that ACBLscore assumed youôd placed at each table.  

(Typically, youôll be changing the last board in each column.) 

When done, hit <F9> or click OK. 
 

You should be able to resume normal data entry. 

 

 

The Very Useful Set Configuration (SE) Option 
 

The Set Configuration (SE) option allows you to change/correct a host of game setup parameters.  

This option is the 1
st
 choice under the Configuration pull-down menu and may also be reached 

by hitting the <F9>  key.  Once youôve selected this option, a window of 13 selections pops up.  

Some of these selections have sub-selections.  Before presenting details of the more useful (or 

dangerous) selections, hereôs a tabular preview of those functions by topic name: 

 

1 Change posting method 

2 Change number of rounds played 

5 Change movement parameters 

7 Set tie breaking spread 

8 Select handicap game 

10 Set masterpoint rating 

11 Assign/change/show STRATA letters/field sizes 

 Note.  Does not change the # of strata -nor- 

 the strata breakpoints. 

 Both are done under selection 10. 

12 Clear ALL names from this section 
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1. Change posting methodðthere are 6 options concerning travelers and pick-up slips 

 é 

 3.  Travelers - Sequence by N-S pair number 

 5.  Travelers by N-S pair, then pick ups by Table number 

If not scoring at game time, # 3 is normal.  With computer scoring, # 5 works. 

Possible reason for changing:  Youôve set up for # 5, but then get pressed into service 

to play.  Pick up slips are no longer useful, and may, in fact, slow down your data 

entry and make it more error prone. 
 

2. Change number of rounds played 

1.  Change starting round 

2.  Change ending round 

Possible reason for changing:  Youôve set up for 10 rounds of 3 boards, but then find 

out people donôt have the time/desire for the extra round.  Youôll want to change the 

ending round from 10 to 9. 
 

5. Change movement parameters 

You do get to confirm that you want to reconfigure.  If yes, you select from 

Mitchell/Howell/Web/ é.  There are a whole raft of parameters once you select the basic 

movement.  Among them: 

 Movement type, # tables, # rounds, # bds/rnd, [type of Mitchell], [where the Bye 

Stand is], board duplication, Phantom Pair, Phantom Direction, Phantom Table # 

Possible reason for changing:  You called the Skip later (or maybe earlier) than 

ACBLscore was expecting.  After drilling down to the Select player board duplication 

option window, youôll probably have to select Other to enter the round the players 

actually skipped.  Earliest to Skip:  # rounds - (# tables/2);  latest to Skip:  # tables/2. 
 

7. Set tie breaking spread 

 Default = .01 
 

8.  Select handicap game 

Note.  A handicapped game is not allowed with a Stratified Event.  Stratification is the 

preferred method for allowing lower ranked players to place in the event (and also for 

increasing the number of points awarded). 
 

10.  Set masterpoint rating 

Careful here!  Once you start, you canôt back out.  Gives many game parameters, 

including: 

Club #, session #, Open/Invitational, # of strata, strata breakpoints. 
 

11. Assign/change/show STRATA letters/field sizes 

1. Specify stratum letters in section ñx.ò  When the table of player names appears, press 

<F3> to auto stratify the entire table. 

2. Change strata designation lettersðif you select this option and canôt exit via either 

OK or CANCEL, try the <Esc> key. 

3. Display strata breakdownðshows # of pairs in each strat by Direction. 
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12. Clear ALL names from this section 

Be especially careful here.  You do get to confirm before continuing.  Not only are ALL 

names deleted, but also ACBL #s and the stratum for the pair.  I hope to never get the 

names so jumbled up that I need to do this. 
 

Of the 13 possible selections, # 10, Set masterpoint rating, is likely to be the most useful.  If 

youôre planning to re-stratify the game to get about equal numbers of pairs in the different strats, 

this is where you go to reset the strata breakpoints.  Then you select #11 to auto stratify using the 

new strata breakpoints. 

 

 

Special Scoring, Such as A+ or A- for both N-S and E-W 
 

Sometimes you want both pairs at a table to receive average plus or average minus on a board.  

Other times you may wish to assign different N-S and E-W scores on the same board.  When you 

are entering the scores, first hit the ñSò key (for special scoring).  The words SPECIAL 

SCORING appear highlighted near the bottom left and the data entry window changes from 

SCORE: to N-S SCORE:.  For average plus, enter A+.  A new data entry window appears to the 

right for E-W SCORE:.  Enter A+ again.  For average minus, enter A- first for N-S and then for 

E-W.  For different N-S and E-W scores, simply enter the score in the appropriate window. 

 

 

Adjusting the Match Points for a Pair 
 

With an emphasis on Zero Tolerance and attention to improprieties, as a director you may need 

to adjust a pairôs match point score.  This is easily done in ACBLscore, but you may harbor a 

misconception or two on the process.  The adjustment you make: 

1) is in match points, up to 2 decimal places.  Even if you tell the offenders youôre going to 

penalize them ӎ or ı board, it is up to you to convert that percentage to a number of 

match points, 

2) is assigned to the pairôs session total, not to a particular board, 

3) will not show up on the Section Leaders report, i.e. the score will be adjusted, but the 

adjustment itself will not be displayed, and 

4) will be displayed in a full report in an ñAdjustò column just to the right of the Score 

column. 
 

The first time you go through the Adjustment process, you might use the Section Leaders report 

as a quick way to verify youôve correctly made the adjustment.  Bring up the Section Leaders 

report on screen.  Note the Score of the pair you are going to penalize.  Make the adjustment.  

Bring up the Section Leaders report on screen again.  Verify the score has been adjusted 

appropriately. 
 

Now for brass tacks.  With the game on screen: 

 Click the Edit pull-down menu (2
nd

 from the left) 

 Click Adjustments (about ӏ of the way down) 

Adjustments brings up the N-S and E-W pair names in a table very similar to the one used to 

enter the player names.  One difference is an ADJUST column has been added to the right of 
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each column of names.   <F6> starts with N-S 1 and allows sequential entry of adjustments (via 

the Enter key).  Alternatively, use the arrow keys to select a specific pair, then press the Enter 

key.  Enter the adjustment for the pair and press the Enter key.  When finished, press <F9>. 
 

Adjustments may be upward as well as downward.  For a negative adjustment, you may press the 

Minus key at the start of the numeric amount or at the end. 
 

Thatôs all there is to it. 

 

 

ACBLscoreôs Import / Export 
 

If youôve scored a game entirely and then discover a mistake in setting up the game that you 

canôt undo/correct using <F9> or some other technique, you might be able to recover using the 

Import / Export feature from the File drop-down menu.  One such mistake is selecting the wrong 

club (number).  I did this for a morning game and was able to recover without re-entering all the 

scores as follows: 
 

1. renamed the ñACMò file to ñACAò 

2. created a new game file for the morning game using the proper Club #, and also set up 

Section A appropriately 

3. clicked the File drop-down menu, and then Import / Export 

4. next, I clicked on From another game file and specified the game file, the one with the scores 

in it, newly renamed in step one (1) 

5. I generated an on-screen report to verify the results were as previously given. 

6. finally, I did the DBADD. 
 

The main point here is using the File, Import / Export feature to import the names and scores 

after setting up the configuration properly. 

 

 

Printing/Viewing the Results at the Game 
 

If you have a computer and printer at the Game, you can do the data entry and print a recap for 

the players.  If you donôt have a printer, you can still display the results on the computer screen.  

ACBLscoreôs pull-down Reports menu (3
rd

 from the right) offers you lots of formatting choices.  

When you click on Reports, a list of 16 possibilities pops up.  Weôll cover only a few of them 

here. 
 

   Standings at the End of the 2
nd

 Last Round    

The Section Leaders (LE) choice (2
nd

 from top) is appropriate for printing the standings at the 

end of the penultimate round.  When you click this item, youôre offered a choice of Screen / 

Printer / Text File.  Since you need to use the computer to enter the last round scores, only the 

Printer selection makes sense. 
 

   Final Standings    

The List (LI) choice (at the very top) is suitable for printing the final standings.  It shows each 

pairôs strat and the Masterpoint Awards for the field.  When selected, youôre offered a choice of 

Screen / Printer / Text File.  If you have a printer and time to post a hard-copy, select Printer.  
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Otherwise, select Screen.  In the next window that pops up, accept the default selection of By 

rank.  Either post the hard-copy, or turn the screen so the interested players can view it. 
 

   Summaries for Individual Pairs    

This choice (5
th
 from the bottom) allows you to print out individual pair Match Point summaries 

for 1 or all pairs in the game.  Youôre on your own to explore the sub-menus of this one. 
 

   Printing a Full Recap    

1. Find the word ñReportsò on the top menu bar and click on that. 

2. Go partway down that menu to ñRecap/Press > Screen/File (LR)ò and click on that. 

3. Youôll get a small window, which asks for 1) Screen, 2) Printer, 3) Text file, or 4) HTML 

file.  Select ñPrinterò and click on ñOK.ò 

4. In the next window, select #5: List + Recap.  Click OK. 

5. Next window: report width should be at least 114.  Click OK. 

6. Next window: if you have a game with N-S and E-W winners, youôll be asked if you want 

to include the N-S Recap.  Answer ñYesò or OK. 

7. In the next window, select ñBy rankò and click OK. 

8. Click ñYesò or OK for the E-W Recap. 

9. Take the sheets from the printer and post them someplace convenient for viewing. 

(If you have the Vista operating system and ACBLscore/Vista doesnôt talk to your printer, after 

saving a ñtextò format copy of the fileðsee 2 sections ahead, Saving a Copy of the Game File in 

ñTextò Formatðyou may open the ñTXTò file in Notepad or Wordpad to print it out.  Be sure 

NOT to save it, which might change its formatting.) 

 
 

DBADDing the Game 
 

Adding the game to the database of player informationðby doing the DBADD stepð may not 

be critical to your purposes, but it is generally advisable to do so.  For instance, your attendance 

(& masterpoints won) records wonôt be accurate if you donôt transfer the file to the database. 

1. From the drop-down menus across the top, click Event. 

2. Select the second item on the list:  Transfer to data base (DBADD). 

3. A message about the Data Base not being prepared may appear.  Just click ñYesò to 

continue. 

4. Click ñOKò in response to each of the next three windows (ñNo report,ò ñMasterpoint 

awards,ò and ñAll players in this gameò).  The last line of the game information screen 

will change from ñDBADD not doneò to ñMasterpoints done.ò 
 

 

Saving a Copy of the Game File in ñTextò (or HTML) Format 
 

Before posting a game file to the Ventura Unit web site, it must be converted to a ñtextò file from 

the computer language itôs in.  (If youôre uploading to the ACBL website, you need an HTML 

formatted file.)  ACBLscore is the mechanism to do that.  You end up with the original file and a 

copy in ñtextò format (or HTML). 
 

1. Find the word ñReportsò on the top menu bar and click on that. 

2. Go partway down that menu to ñRecap/Press > Screen/File (LR)ò and click on that. 
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3. Youôll get a small window, which asks for 1) Screen, 2) Printer, 3) Text file, or 4) HTML 

file.  Select ñText fileò (or HTML for the ACBL website) and click on ñOK.ò 

4. The GAMEFILE directory will appear and the filename (in yymmdd format) will appear on 

the ñsaveò line at the bottom.  This time, however, the filename will have the letter ñAò (for 

afternoon) after the date, or possibly ñMò (for morning) or ñEò (for evening) or ñLò (for 

late).  Click ñSave.ò 

5. In the next window, select #5: List + Recap.  Click OK. 

6. Next window: report width should be at least 114.  Click OK. 

7. Next window: if you have a game with N-S and E-W winners, youôll be asked if you want 

to include the N-S Recap.  Answer ñYesò or OK. 

8. In the next window, select ñBy rankò and click OK. 

9. Click ñYesò or OK for the E-W Recap. 
 

Posting to the Ventura Unit web site is covered in the separate write-up:  Posting Bridge Game 

Results to VCBridge.org.  Uploading to the ACBL website is covered in:  Saving and Uploading 

Club Game Results.  Both are found on www.vcbridge.org by following the menu path 

 Writings / Directorôs Dialog. 

 

 

Doing the Game Recap in Multiple Formats (via Append) 
 

Before posting the already-created recap report to the web site, you can again go through the 

steps to generate a recap report and youôll be given the option to ñReplaceò or ñAppend (to)ò the 

old report.  Youôll select ñAppend.ò  Note, the HTML file appends automatically. 
 

Examine the different reports by sending them to the ñScreenò in step 3 in the Saving a Copy of 

the Game File in ñTextò Format section.  If you do find a second format you like, at step 3 select 

ñText file.ò  At step 4, you specify the name of the file already created, and then click on the 

ñAppendò option.  Continue on, selecting the alternate format that youôve chosen to complement 

your primary format. 

 

In Feb 2010, the Ventura Unit Board recommended not saving as # 5 (at step 5 of Saving a Copy of 

the Game File in ñTextò Format), but instead 1
st 

saving in format 7 (List only), then appending 

format 4 (Short Press + Recap). 

 

 

Annotating a Revised Text File 
 

If youôve already posted the game, and an error comes to light, after correcting the game, youôll 

need to repost it.  Donôt forget to DBADD the game file again and e-mail the ACx file to Tom 

Ciacio, see Preparing the Game File for the Monthly Report.  But first you might want to 

annotate the text file so people know itôs the revised/updated version.  Open the revised ñTXTò 

file in Notepad.  Create a new line at the top and enter an annotation, something like 

ñREVISEDò or ñREVISION 1.ò 
 

The separate write-up, Posting Bridge Game Results to VCBridge.org, has a section near the end 

on Reposting the Text File to the Web Site. 

 

http://www.vcbridge.org/
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The Monthly Report 
 

Currently (June 2010), Tom Ciacio (tciacio@unit547.org), the Unitôs Club Manager, is taking 

care of the monthly report for the Ventura unit-owned games (Tu/We/Th/Sa) and you need to 

e-mail him the game fileðthe one that has an extension of ñ.ACAò for an afternoon game, or 

ñACMò for a morning game (starting before 12 noon), or ñACEò for an evening game (starting 

after 6 P.M.). 
 

Should you need to do the monthly report for a club, look for the write-up entitled The (Club) 

Monthly Report on www.vcbridge.org if you need guidance. 

 

 

Editing the ACBLScore Players Database 
 

If you receive updated information about an ACBL member or have a brand new name to add to 

the ACBLScore Databaseðwhether a member or notðACBLScore itself will let you perform 

the update. 
 

1. Launch ACBLscore. 

2. Click the Data Base drop-down menu button, the 3
rd

 from the left. 

 
3. Click Update/Find (Players), 1

st
 choice in the list. 

This brings up the ACBLScore Players Database window. 

mailto:tciacio@unit547.org
http://www.vcbridge.org/
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a) The 2

nd
 line tells us the actual filename is PLAYERN.DAT and in this example the 

number of records with player information is 1266. 

b) The 4
th
 line gives the Player Name and ACBL #, if any. 

c) Note the row of buttons at the bottom of the window. 

3
rd

 from the left is Find. 

7
th
 from the left (=4

th
 from the right) is Add. 

4. Click the Find button at the bottom of the window. 

5. In the new window, type in 1 or more letters of the last name of interest and click the OK 

button. 

6. A new window with a list of names should appear.  Select the one you want to update and 

click the OK button. 

7. Assuming the proper name is displayed, click the Edit button (6
th
 from the left) at the 

bottom of the window. 

8. Click in any field to change it. 

9. When done changing fields, click the Done button ( ), which has appeared to the 

right of the Player #, toward the upper right. 
 

10. If you have a brand new player entry, click the Add button.  Fill in whatever information 

you have and when done, click the Done button ( ). 
 

11. When you are done with everything, you may exit in either of 2 ways: 

1. Click the red X in the upper right, 

2. Click the Quit button in the bottom right. 
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Club Setup 
 

Whenever you direct an ACBL-sanctioned game, certain information concerning the club and 

the particular session is required.  You may enter this information each and every time, or you 

may simplify your directing chores by using the Club Setup option to enter this information one 

time only.  Most directors opt for the latter. 
 

Select Data Base from the Main Menu.  Then select Club Setup from the window that comes up.  

If no clubs are entered, you must press ñAò for Add or click the gray ñAddò button at the bottom 

of the window.  ACBLscore will enter the Add Mode  (If the buttons at the very bottom of the 

window look familiar, itôs probably because theyôre identical to the ones that appear when you 

edit the playersô database.)  After youôve entered your club information, save it by pressing the 

on-screen ñDoneò button  that appeared when you selected Add.  As implied earlier, this 

club information will come up by default whenever you create a new game file for this club. 
 

 
 

In the screen capture above, note that the area describing a club has a light green background.  

This background color indicates the active area, which may be the Club area or the Session area 

that appears directly below it.  A second indicator is the bar between the Session area and the on-

screen buttons area.  This bar is called the mode bar.  It says Club Record Mode when the Club 

area is active, or Sanction Record Mode when the Session area is active. 
 

To move among the club records, use the on-screen Next or Prev buttons or the up/down arrow 

keys.  Before you can edit an existing club record, you must hit the on-screen Edit key at the 

bottom of the window.  ACBLscore will enter the Edit Mode and will hide the information in the 

session area and the on-screen button area.  You may tab through the fields to edit them or use 

Club Area 

Session Area 

mode bar 
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the mouse to go directly to a particular field.  When finished, hit the on-screen ñDoneò button 

 that appeared when you selected Edit. 
 

If you need to edit an existing Session or add a new one for a club, simply press the on-screen F2 

key or the physical <F2> key on your keyboard.  The <F2> key toggles between Club and 

Session mode. 
 

 
 

The screen capture above is in session mode as indicated by the light green background in the 

Session area and by the words Sanction Record Mode on the mode bar just below the Session 

area.  Use the mouse or the up/down arrow keys to select a particular session.  To modify a 

session, click the on-screen Edit key at the bottom of the window.  ACBLscore will enter the 

Edit Mode.  You may tab through the fields to edit them or use the mouse to go directly to a 

particular field.  When finished, hit the on-screen ñDoneò button  that appeared when you 

selected Edit. 
 

Use the <F2> key/on-screen F2 button to toggle back and forth between Club and Session mode.  

When you are done with everything, you may exit in either of 2 ways: 

1. Click the red X in the upper right, 

2. Click the Quit button in the bottom right. 

 

 

Set Path 
 

In addition to the Club Setup option, the Set Path option may help simplify your directing life if 

you direct at several different clubs.  Select Setup from the Main Menu.  Then select Set Path 
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from the window that comes up.  Youôll be presented the option to set 2 different computer paths 

of interest: 

1. The Directory where references to the Game file (for storage & retrieval) will go, 

2. The Directory where references to the database of player records, including attendance at 

games, will go. 
 

To make a change, click the file folder icon to the right of each path.  Then scroll the list of 

directories to select a different one.  Multiple Game file directories can be beneficial in keeping 

the size of any particular Game file directory to manageable size.  It may also simplify some 

reports by eliminating the need to specify game(s) of interest. 
 

Letôs say one of the different games you direct is Invitational and frequently asks for reports on 

attendance and points won at their game only.  Letôs call this club the Grand Vista club.  Under 

ACBLSCOR, I would create a directory named: 

 GAMEFILE ï GV 

Whenever I direct at Grand Vista, my standard setup process would include changing the game 

file directory to GAMEFILE ï GV.  When done with the game, I would change back to the 

vanilla GAMEFILE directory. 
 

Another possible application of this technique would be directing on a cruise.  Letôs say the 

cruise line is Holland America.  Now, I would create a GAMEFILE ï HA directory.  An 

advantage here in that any reports I do for my other games would not be cluttered by 

players/games I directed only on the cruise line. 
 

Thinking of the Grand Vista club again, for that clubôs ñaward year,ò I might be asked to 

regularly post masterpoints won to date in that club.  I could create a DBASE ï GV directory 

under ACBLSCOR.  Whenever I direct at Grand Vista, my standard setup process would include 

changing the database directory to DBASE ï GV.  When done with the game, I would change 

back to the vanilla DBASE directory. 
 

When doing the masterpoint race report for Grand Vista, I would switch to DBASE ï GV to 

ensure I was getting only points won in the Grand Vista club. 

 

 

 

Ventura Unitôs web site: 

 http://www.vcbridge.org 

 

 

 

Table Marker Colors 
 

A White C Green E Blue 

B Yellow D Orange F Pink 

 

 

 

http://www.vcbridge.org/
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Windows Explorer under the Vista Operating System 
 

    Putting a Windows Explorer Shortcut on the Desktop    

Left click the Windows ñStart Menuò ball on the Taskbar in the lower left of the screen. 

Select ñAll Programs.ò 

Select the ñAccessoriesò folder. 

Right click on ñWindows Explorer.ò 

Select ñSend To.ò 

Click on ñDesktop (create shortcut).ò 
 

   Removing ñHide extensions éò from Windows Explorer    

Open ñWindows Explorer.ò 

Click the leftmost drop-down menu, ñOrganize.ò 

A window for ñFolder and Search optionsò comes up. 

Click the middle tab, the View tab. 

Not quite halfway down the list, ensure ñHide extensions for known file typesò is unchecked. 

Click ñOK.ò 

 

 

 
   ACBL Club Numbers:    

127100  Ojai Valley Civic Bridge Club Monday & Friday at 12:30 

131102  Ventura Unit Bridge Club  Tuesday, Wednesday, Thursday at 12:30 

 Saturday at 11:30 (at P.V. Sr. Center in Camarillo) 

257501  Oxnard Club under Halls  Wednesday at 12:00, closed Fall 2010 

[ 206938  Buenaventura Bridge Club  defunct ] 

248807  Lexington Duplicate Bridge Club Sunday at 1:00 P.M. 
 

243386  Pleasant Valley Bridge Club  (Camarillo Tuesday & Friday at 11:55 A.M.) 

This club is sanctioned under the Southern Gold Coast unit.  Nonetheless, its results are 

posted on the Ventura unit web site.  However, the ñACMò file is e-mailed to Bob 

Gruber (robertmgruber@aol.com) and nothing is sent to Tom Ciacio. 

143636  Las Posas CC/Bridge Club  Camarillo Wednesday at 11:00 

This INVITATIONAL club is sanctioned under the Southern Gold Coast unit. 

234658  Spanish Hills DBC   Camarillo 2
nd

 & 4
th
 Thursday at 10:30 

This INVITATIONAL club is sanctioned under the Southern Gold Coast unit. 

mailto:robertmgruber@aol.com

